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Chapter 1. IBM Campaign 10.1 system requirements and
compatibility

IBM® Campaign is part of the IBM Marketing Software suite of products.
Campaign version 10.1 requires Marketing Platform 10.1.

Where to find complete system requirement and compatibility
information

For a list of IBM Marketing Software product versions compatible with this
product and a list of third-party requirements for this product, see the
Recommended Software Environments and Minimum System Requirements document.
This document is posted under Detailed System Requirements on the IBM Support
Portal website: (http://support.ibm.com).

You can also access this document by selecting Help > Product documentation
when you are logged in to IBM Marketing Software.

Prerequisites for using IBM Campaign
Before you begin using IBM Campaign, confirm that your environment meets the
following requirements.
v For an improved user experience, use at least a 21" screen.
v For an improved user experience, set your screen resolution to 1600 x 900.

Lower resolutions can result in some information not being properly displayed.
If you use a lower resolution, maximize the browser window to see more
content.

v A mouse is best for navigating in the user interface.
v Do not use the browser controls to navigate. For example, avoid using the Back

and Forward buttons. Instead, use the controls that are in the user interface.
v If pop-up blocker (ad blocker) software is installed on the client machine, IBM

Campaign might not function properly. For best results, disable pop-up blocker
software while running IBM Campaign.

v Ensure that the technical environment meets the minimum system requirements
and the supported platforms.*

v The correct browser and versions must be used.*
v Clear the browser cache after upgrading or applying any fix pack. This only

needs to be done once, after the application is updated.
v If you use Internet Explorer (IE) with IBM Campaign or any module that uses

Campaign flowcharts (eMessage, Contact Optimization, Interact, Distributed
Marketing): To log in multiple times to view side-by-side information, open IE
and log in to IBM Marketing Software. Then select File > New Session in the IE
menu bar. In the new IE browser window, log in to IBM Marketing Software as
the same or a different user.

Important: Do not use any other method to open multiple sessions. For
example, do not open a new tab; do not open another browser session from the
Start menu or desktop icon; and do not use File > New Window in IE. These
methods can corrupt information that is shown in the application.
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*For details on the items indicated by an asterisk, see the IBM Marketing Software
Recommended Software Environments and Minimum System Requirements.

IBM Campaign documentation roadmap
IBM Campaign provides documentation and help for users, administrators, and
developers.

Table 1. Get up and running

Task Documentation

Find out about new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign
system tables

IBM Campaign System Tables and Data Dictionary

Install or upgrade Campaign One of the following guides:

v IBM Campaign Installation Guide

v IBM Campaign Upgrade Guide

Implement the IBM Cognos® reports provided
with Campaign

IBM Marketing Software Reports Installation and Configuration
Guide

Table 2. Configure and use Campaign

Task Documentation

v Adjust configuration and security settings

v Prepare Campaign for users

v Run utilities and perform maintenance

v Learn about integrations

IBM Campaign Administrator's Guide

v Create and deploy marketing campaigns

v Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance IBM Campaign Tuning Guide

Use Campaign functions IBM Macros for IBM Marketing Software

Table 3. Integrate Campaign with other IBM products

Task Documentation

Integrate with IBM Engage IBM Campaign and Engage Integration Guide for IBM Marketing
Cloud

Integrate with IBM Journey Designer http://www.ibm.com/support/knowledgecenter/SSER4E/
JourneyDesigner/kc_welcome_journeydesigner.dita?lang=en

Integrate with IBM Digital Analytics IBM Campaign Administrator's Guide: How to configure the
integration

IBM Campaign User's Guide: Targeting IBM Digital Analytics
segments in campaigns

Integrate with IBM Marketing Operations IBM Marketing Operations and IBM Campaign Integration Guide

Integrate with IBM Opportunity Detect IBM Campaign Administrator's Guide: How to configure the
integration

IBM Opportunity Detect Administrator's Guide and IBM
Opportunity Detect User's Guide: How to administer and use the
product
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Table 3. Integrate Campaign with other IBM products (continued)

Task Documentation

Integrate with IBM eMessage IBM Campaign Installation and Upgrade guides: How to install and
prepare eMessage components in the local environment.

IBM eMessage Startup and Administrator's Guide: How to connect
to the hosted messaging resources.

IBM Campaign Administrator's Guide: How to configure offer
integration.

Integrate with IBM SPSS® Modeler Advantage
Enterprise Marketing Management Edition

IBM Campaign and IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition Integration Guide

Integrate with IBM WeatherFX. You can integrate WeatherFX with IBM Campaign so that you
can pull weather events into your marketing campaigns.
Campaign version 9 and version 10 users can integrate with
WeatherFX by using the UBX toolkit. For more information, see
https://www.ibm.com/support/knowledgecenter/SSWU4L/
Integrations/imc_Integrations/
Weather_FX_for_IBM_Marketing_Cloud.html.

Note: Additional integrations may be available that are not listed in this table. See Product tools and utilities for
IBM Campaign. Also see IBM Solution Engineering Projects.

Table 4. Develop for Campaign

Task Documentation

Use the REST API See the IBM Campaign REST API

Use the SOAP API v See the IBM Campaign SOAP API Specification

v JavaDocs in devkits\CampaignServicesAPI

Develop Java™ plug-ins or command-line
executables to add validation to Campaign

v See the IBM Campaign Validation PDK Guide

v JavaDocs in devkits\validation

Table 5. Get help

Task Instructions

Use the IBM Knowledge Center Go to http://www.ibm.com/support/knowledgecenter/
SSCVKV/product_welcome_kc_campaign.dita

Open online help When using the IBM Campaign application:

1. Choose Help > Help for this page to open a context-sensitive
help topic.

2. Click the Show navigation icon in the help window to
display the full help.

You must have web access to view context-sensitive online help.
Contact IBM Support for more information about accessing and
installing IBM Knowledge Center locally for offline
documentation.

Get PDFs When using the IBM Campaign application:

v Choose Help > Product documentation to access Campaign
PDFs.

v Choose Help > All IBM Marketing Software documentation
to access all product PDFs.

v Click the links for PDFs during the installation process.
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Table 5. Get help (continued)

Task Instructions

Get support Go to http://www.ibm.com/ and click Support & downloads to
access the IBM Support Portal.
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Chapter 2. New features and changes in version 10.1

IBM Campaign 10.1 includes a number of new features and changes.

For a list of newly supported and discontinued platforms, see the document
Recommended Software Environments and Minimum System Requirements, which is
posted under Detailed System Requirements on the IBM Support Portal
(http://support.ibm.com).

Upgrade paths

You can upgrade to Campaign version 10.1 directly from version 10.0.

If you are using Campaign version 8.6.x, 9.0.x, or 9.1.x, you must first upgrade to
version 10.0 and then upgrade to version 10.1. For more information, see the IBM
Campaign 10.1 Upgrade Guide.

Sync fields for audience information in IBM Engage

When you complete a test run or a production run, audience information is
exported by IBM Campaign to IBM Engage. Now, for the Email and Push
processes, you can specify the fields that must be used as sync fields for the
audience information.

For the Email and Push processes, the campaignaudienceId is used as the sync field
by default. For the SMS process, the phone number is used as the sync field.

To set the sync fields, go to the Field mappings tab of the Email or Push process.
Select the Fields to export to Engage and complete the mapping. Click the check
mark in the Sync column for the field or fields that are to be used as the sync
fields.

New configuration property: allowableFailurePercentage

A new configuration property, allowableFailurePercentage, is added to the
Campaign | partitions | partition[n] | Engage properties.

When a campaign contact list is processed in Engage, an error is returned to
Campaign if a contact fails for any reason. You can now use the
allowableFailurePercentage property to specify the percentage of failed records
that are allowed before the campaign process fails. If the percentage of failed
records is greater than the configured allowableFailurePercentage, the process
fails.

If the percentage of failed records is less than or equal to the configured
allowableFailurePercentage, the process does not fail. Duplicate records are
considered as valid records and so they do not affect the
allowableFailurePercentage for a process box. All valid records are imported into
Engage.

Any warnings and errors for the process are logged in the ImportErrors log file.
You can delete this file at regular intervals. The ImportErrors log file is located in
the <Campaign_home>/logs folder.
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CampaignAudienceID is uploaded to Engage for SMS and Push
processes

The CampaignAudienceID is now uploaded to Engage for SMS and Push
processes. The CampaignAudienceID was previously uploaded to Engage for the
Email process. It is used for tracking purposes.

Refresh button added to Field mappings tab

A Refresh button 
 

is added to the Field mappings tab of the Email, SMS, and
Push processes. Use this option if any new fields are added to the Engage database
or if any existing fields are modified.

Note: You must validate all the field mappings after refresh completes.

Campaign name field size increased to 256 characters

The size of the campaign name field on the Content Customization tab of the
Email, SMS, and Push processes is increased to 256 characters. This includes the
timestamp that is appended and the campaign code that is added as a prefix. If the
number of characters for the campaign name exceeds 256, the name that is entered
by the user is truncated.

Engage properties tab changes

For the Email, SMS, and Push processes, on the Engage properties tab, the default
option for Use single contact list is changed to Update matching contacts; add
contacts that are not found.

Send to all contacts immediately option is disabled until a
template is selected

For the Email, SMS, and Push processes, n the Content Customization tab, the
Send to all contacts immediately option is available only after you select the
template.

Campaign and Engage integration logs

When Campaign and Engage are integrated, integration logs can be set in
campaign_log4j.properties file available in the <Campaign_home>/conf/ folder.

The name of the class is
log4j.logger.com.unica.webservices.campaign.rest.EngageImportService.

Logs are captured in INFO, WARN, and DEBUG modes.

The log file can be found in the <Campaign_home>/logs folder.

WSReference parameter added to createCampaign API

A new WSReference parameter is added to the createCampaign API. Use this
parameter to specify the folder in which the new campaign is to be created.
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Performance improvement for copy-pasting a flowchart in a
campaign

Performance is improved for the copy-pasting of large flowcharts that have a large
number of output Cells.

Campaign - Engage integration error file download

In previous versions, if the err file from Engage was not downloaded in the first
attempt, the process failed. Now, if the file is not downloaded in the first attempt,
a maximum of 5 attempts are made to download the file before the process fails.
The debug level log file contains the information about the multiple attempts.

Filtering for mapped user tables

You can filter the mapped user tables that appear in the Table mappings window.
The mapped user tables can be filtered by table name.

In the Select process box, you can filter the mapped user tables that appear in the
Available Fields section in the Select process configuration window. For more
information, see the IBM Campaign Administrator's Guide and the IBM Campaign
User Guide.

New link for product support

A new link is added under Help > Support for this product. Use this link to access
documentation for the product on IBM Knowledge Center.
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Chapter 3. Fixed defects in IBM Campaign 10.1

The following defects were fixed in Campaign 10.1.

Table 6. Campaign fixed defects

ID Fixed defect

178526 The following error is logged if you interrupt and then restart the Campaign installation.
You can safely ignore the following non-fatal error in the Campaign_Install.log.

"com.unica.install.ia.custom.ManagerReadConfigurationStatus: ERRORAdditional
Notes®: ERROR - class com.unica.install.ia.custom.ManagerReadConfiguration
NonfatalInstallException The processing instruction target matching "[xX][mM][lL]"
is not allowed."

184919 Big data: Mail List process execution fails with error: unique constraint
(UCDUC9111.CCONTACTHIST_PK) violated.

Mail List / Call List process box execution completes successfully when User Database
table - Audience Level is BigInt. However:

v When a user profile table contains Audience ID in Decimal format, this error occurs.

v When a user profile table is created by export from File to Database then by default all
numeric fields are created as Decimal.

For big data: The user profile database table audienceID should be of BigInt type when
used with DB2 databases. If the user profile database table audienceID is Decimal, the Mail
List / Call List process box execution will have errors.

APAR PO05193,
196259

In a clustered environment, if you schedule a Campaign flowchart to Run now in the
Marketing Platform scheduler, the run status is not updated when you view it from within
the flowchart.

APRAPO05353, 199729 Cross site scripting issues occur when the user uses a browser version that is not
supported. This is applicable for all unsupported version of Firefox, Internet Explorer and
Chrome browsers.

213372 Some searchable fields cannot be searched in the Extract process box. The Optimize list
referenced in the Extract process box is not searchable in the Flowchart Advance Search
feature.

219602 Engage: Push process box execution fails when all mapped fields are marked as Sync fields.
Push process box execution fails with the following error message: 21901: Internal error.
Error received from IBM Engage: Error executing import of list. Details: Error
Appending and Updating Recipients. Job id:

This error occurs when a user marks more than the required fields as synch fields. In
Campaign, users can mark only those fields that are allowed as Sync fields in the Engage
database as Sync fields.

APAR PO05520,
225559

If a Campaign custom attribute that contains non-English characters is exported to a
mapped database table, the attribute value is truncated.

APAR PO06187,
226297

A round bracket "(" in the process box name is displayed incorrectly in the Cell reports as
a single right square bracket "]".

226794 Campaign Listener Silent mode installation does not set MasterListnerPriority and
LoadBalancer weight configuration parameters.

Users must manually set these configurations under Marketing Platform configuration.

226975 Campaign web application cannot connect to Campaign listener when
masterListenerPriority and loadBalanceWeight are the same for all listener nodes.

© Copyright IBM Corp. 1998, 2017 9



Table 6. Campaign fixed defects (continued)

ID Fixed defect

PMR 218840, 228837 Insufficient information is available in the log files to identify the root cause for the
Campaign error 11107. This error occurs when an opened process box contains persistent
Derived fields that are deleted from upstream process boxes.

APAR PO06410,
228845

Scheduled flowcharts fail with error 1783 in listener cluster environment.

APAR PO06331,
230046

In the query of the segment in a Segment process box, round brackets disappear when we
add an operator after the closing round bracket. When a user selects query rows and
removes the round bracket, it is not been removed.

PMR 211651, 230546 A Campaign out of memory error occurs due to heap being consumed by session data.

PMR 193502, 230553 While using the Safari browser, if there are lots of templates in the template menu, the time
required to load the template might exceed the default screen timeout of 60 seconds. The
screen time out and no templates are loaded.

APAR PO05875,
230555

When a user with locale preference set to Italian creates a campaign and a flowchart in the
Italian locale, the Flowchart Palate is not displayed correctly.

APAR PO06554,
231385

The default directory for selecting the input data is set to the directory that is defined as
the defaultOutputDirectory instead of the directory that is defined as the
defaultInputDirectory in Campaign | partitions | partition[n] | server | fileDialog.

231396 In a clustered environment, the Mail list process execution fails when a smart offer list is
assigned to the mail list.

APAR PO06582,
231983

When a user adds a round bracket in the query section of a process box using query
builder, saves the process box and tries to remove the bracket from the expression, the
bracket is not removed.

232095 advSrchUtil command sometimes cannot create index for Deep search. Users must log in to
the IBM Campaign application go to the IBM Campaign page before running advSrchUtil.

PMR 231995, 232527 When an offer is created by using the createOffer API, the offer name is not validated for
special characters.

PMR 233720, 234297 In the Extract process box for the in Candidate Fields in the Extract tab, when the user
selects a field by using the mouse and then selects another field, then uses the Up or Down
keyboard keys, the focus moves to the first field that was selected by the user.

PMR 195194, 234421 When a user with the locale fr_FR configures a flowchart with a Mail list, navigated to the
Parameter tab of the Mail list process, and parametrizes the Date field attribute, the IBM
Campaign generated fields label is blank.

APAR PO06485,
234422

Users cannot rename a session flowchart.

234913 No error occurs on Mail list process with multiple input cells when the assigned PDF is
removed.

APAR PO06003,
235307

After pasting from template library, the table is mapped with the first table in the list.

235602 Campaign application does not start on Websphere 8.5.5.7.

APAR PO06031,
238206

Users cannot increase the width of the Datasource column in the Table mapping window.

238208 For the Select process, the round brackets for an Expression are truncated when the
AND/OR operators are changed.

APAR PO05898,
239361

When a user with the locale set as French or Italian opens a Sample process and clicks on
Sample size calculator, the minimum and maximum values keep flickering.

239625 Logging is not correct if ETL to dtlcontactHist fails. Logs are saved in the ETL.log file
instead of campaignweb.log or EngageETL.log files.

239749 The application user interface performance slows for an Offer list with 1500 offers.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

APAR PO06850,
240166

If the date 29 February is passed as a value in the date_format macro, it fails with a 334:
Invalid arguments error.

241005 SPSS Score process fails on a Cluster setup.

241130 An exception occurs if the identifier is NULL for Event Message Sent.

241563 When a single Campaign has more than 50 flowcharts, it take a longer time that usual to
list all the flowcharts when a user View a tab or Edit a tab.

242358 Dimension tables are not visible under the second Base table node in the Table mapping
window when we use Dimension fields of first base table or existing Dimension tables.

APAR PO06928,
242661

If the property setting DeleteAsRecreate is changed from FALSE to TRUE under
Campaign|partitions|partition1|dataSources|UA_SYSTEM_TABLES, an error occurs and the
recreation of the table UACO_OCT000000XX for the Contact Optimization session fails with
the error message "ORA-01727: numeric precision specifier is out of range 1 to 38."

PMR 242776, 243361 When the sort API is called, for sessions, there is no indication on the user interface that
the response has not been received from the server as yet.

APAR PO06240,
244938

If the table that is selected for the Select Based on field in the Select process is remapped
and the case for the table name is changed in Campaign table mapping, when the Select
process is opened again, the Select Based on field is set to None but the previous table is
still used in the query.

APAR PO07037,
245567

When a user uploads phone numbers in the SMS process, the Customer ID is uploaded
instead of the phone numbers in the contact list for Engage. If the user maps a text column
along with the phone number, the text is written into the phone number field and the
process fails.

APAR PO06278,
246943

When assigning offers within an Optimize process box, offer assignments may change cells
if you assign an offer and then click in the offer field for another cell. At times, an Internal
ID for the offer is displayed instead of the offer name.

APAR PO06791,
247170

The items on the Campaign Analysis tab (Campaign Flowchart Status Summary report) are
not sorted correctly. When you click on date type column name, for example Last Run or
Created on dates, the items are still sorted alphabetically. This occurs when the default
language setting is English (United Kingdom).

APAR PO04374,
265677

Auto complete for drop down menus for target cell attributes does not work.

PMR 270879, 265684 An error occurs and the table cannot be mapped if you map a new table to a file for which
the file name starts with a number.

APAR PO06811,
265686

For the Select process, when a user selects a strategic segment from the Input, the Select
Based On menu does not change and shows None.

APAR PO06314,
265703

In the Select process window, the incorrect value is displayed in the hover help window
when a user selects a particular value in Expression value field and moves the mouse
pointer over the value.

APAR PO06785,
266372

Match/Link target cells to assign an offer in an Optimize box does not work in a Campaign
- Marketing Operations integrated flowchart using top-down design from a published TCS
when you have a Segment>Segment>Optimize logic. The offer assignment made by
Match/Link target cells cannot be changed manually in the process box. Offer changes can
be made to the Marketing Operations TCS and published. Flowchart cells must be unlinked
and linked to reflect the published changes made in the Marketing Operations TCS.

APAR PO06375,
266718

When two platform schedules are created at same time or very close to each other for the
same flowchart, the unica_acsvr process for one of the schedules does not complete.

PMR 247194, 267729 Offer Performance Summary by Campaign report was formed incorrectly from IBM Cognos
in Campaign.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

APAR PO06249,
270510

The IBM Optimize Session Report uses more resources and results is performance issues in
the application.

APAR PO04314,
270517

Unconfigured process boxes appear to be configured and valid after a different branch on
the same flowchart is run.

PMR 269269, 270518 A 10404 error occurs for a flowchart when a user exports a derived field that contains
NULL values to a database table by using the Snapshot process.

PMR 223042, 270519 In a new flowchart, when multiple input process boxes are added to Mail list and
configured to choose additional input cells, the treatment tab shows only the first cell in
Mail list as input. If the flowchart is now saved, the flowchart stops responding.

APAR PO06172,
270615

IBM Campaign Extract process does not write to the DB2 database when a flowchart is
configured with two Extract processes and the second Extract process contains a derived
field that uses French accented characters in the name of the derived field.

APAR PO06787,
270743

You cannot use an HTTPS URL to connect Campaign to IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition.

PMR 270718, 271650 SSLv2 and SSLv3 protocols can be used in IBM Campaign.

APAR PO07062,
271672

While using the Internet Explorer and Chrome browser, when the user sets up a scheduler
based on a new or defined cron expression then the scheduler is defined twice.

APAR PO04314, DEF
178977

Unconfigured process boxes appear as configured and valid after a different branch on the
same flowchart is run.

APAR PO04374, DEF
180108

Auto complete for drop down menus for target cell attributes does not work.

APAR PO05188, DEF
195946

Unable to start IBM Campaign listener with sudo used on Linux server.

APAR PO05593, DEF
204777

A newly created table in DB is displayed at the bottom of the Source Table drop

APAR PO05664, DEF
206862

Scheduling a flowchart fails if the name of the flowchart has a + sign in it. Users must not
use a plus sign, dollar and comma in the campaign name, flowchart name and schedule
name.

APAR PO05724, DEF
210545

Flat file with blank records in it behaves differently for Select and Extract process box.

DEF 213525 Campaign User database HP Vertica: Error occurs while exporting data from table with
Boolean DataType.

APAR PO05898, DEF
215998

For French and Italian users the minimum and maximum values flicker on the "Sample size
calculator" pop-up window.

APAR PO05977, DEF
217550

The "Source" tab is not capitalized correctly when a process box is opened with language
set to Italian.

APAR PO06031, DEF
218629

Unable to increase length of datasource column in Table Mapping screen of IBM Campaign.

APAR PO06151, DEF
221652

Persistent derived fields do not persist in IBM Campaign flowchart branch for users with
locale other than English. Note:This fix is applicable for users creating and editing the
flowcharts with same language settings.

DEF 222087 Offer Folders are not replicated on other cluster nodes of Campaign Web Application.

APAR PO06240, DEF
223861

When a user remaps a table that was taken as input in the select process box and while
remapping the table if the user changes the table name in the Campaign table mapping

DEF 224257 Campaign DeepSearch : Can search by using the description after the description is edited.

APAR PO05794, DEF
225338

Select process box is not retaining the condition given in Expression.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

DEF 225777 Email process box issues in 10.0.

DEF 225779 Push PB issues in 10.0

APAR PO06314, DEF
225802

When the user hovers the mouse pointer over a particular value in the Select expression
value field

APAR PO06217, DEF
225929

All contact history is deleted even after disabling 'Log To Contact History' option

APAR PO06375, DEF
227155

If there are two platform schedules created at same time or very close to each other for
same flowchart

APAR PO06669, DEF
227370

DEF:No error message is added in the Campaign installation log files if the GSKit
files/utilities are not installed.

APAR PO06404 , DEF
227723

Extract process box fails when using input table with composite audience and choosing
Target data source as database instead of IBM Campaign server.

APAR PO06404, DEF
227723

The Extract process failed when you used an input table with a composite audience and
chose a database as the target data source (instead of the Campaign server).

APAR PO06418, DEF
228246

Incorrect values ate inserted into Dtl Contact History in Audience field after running Post
Opt flowchart which uses Optimizedlist in Extract process box.

APAR PO05281, DEF
228262

Flowchart crashes with error 10404 when dotted line between Model and Score process is
deleted.

APAR PO06372, DEF
228383

Existing assigned offer in Optimize process box is not refreshing after changing linked
target cell.

APAR PO06366, DEF
228565

For a particular flowchart run is failing with 'Invalid month' error for alternate executions.

DEF 228838 Error 11107 is displayed when pasting a template in a new flowchart.

APAR PO06410, DEF
228846

Scheduled flowchart fails with error 1783 in listener cluster environment.

APAR PO03936, DEF
229409

For nested Segment processes that use a de

APAR PO04969, DEF
229505

An error “Incommutable sort order detected” in eMessage Process Box occurs when
Flowchart with Select

APAR PO06331, DEF
230045

In a point and click query builder

APAR PO06480, DEF
230070

In a new flowchart

APAR PO06671 , DEF
230129

An issue occurs while scheduling flowcharts that have special characters.

APAR PO06063, DEF
230233

While table mapping performs in IBM Campaign

APAR PO05853, DEF
230234

Control Cell drop down Scroll bar is missing while input is received from 50 or more
segments from maillist.

APAR PO05977, DEF
230235

The "Source" tab is not capitalized correctly when a process box is opened with language
set to Italian.

APAR PO05839, DEF
230236

Mailing links are not displayed in right

APAR PO06198, DEF
230237

Select process box UI is not displaying table columns when table is mapped and named
using reserved word "TARGET".

PMR 229976 , DEF
230239

Scheduling a flowchart that has special character fails and the special characters display
improperly.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

APAR PO05794, DEF
230241

Select process box is not retaining the condition given in Expression.

APAR PO06097, DEF
230245

A copied flowchart with Extract PB while accessing a large table stays paused.

APAR PO06276, DEF
230452

Table Mapping slowdown is seen with large number of tables in a data source when a drop

APAR PO05876, DEF
230454

If the same derived field is used with different names in the Extract output process box

APAR PO06206, DEF
230463

IBM Campaign Generated Fields for Custom Cell and Campaign attributes are not showing
for selection in all process boxes.

APAR PO05762, DEF
230475

Extra brackets added in Value field in Text Builder mode were omitted when changed to
Point & Click mode. This has been fixed.

APAR PO06097, DEF
230476

A copied flowchart with Extract PB while accessing a large table stays paused.

APAR PO05715, DEF
230481

Mapping a flat file is causing performance issue when large number of files exist in the flat
file folder.

APAR PO05775, DEF
230542

Because UserSessionThreadLocal objects were generating

DEF 230552 Template menu can timeout and not load any templates to template menu while the Safari
browser is used.

APAR PO05875, DEF
230554

Flowchart Processes palette is random.

APAR PO06342, DEF
230684

Unable to install Campaign FixPack on 10.0 for German locale.

APAR PO05810, DEF
230685

Performing the following actions impairs the display for segment name and size: Open
segment by query

APAR PO05775, DEF
230686

Because UserSessionThreadLocal objects were generating

APAR PO05708, DEF
230687

Extract Process Box with IN

APAR PO05332, DEF
230688

When Dimension Table is mapped with more than one key field and mapping is done
without any order

APAR PO05150, DEF
230689

When a cell report is opened on a smaller screen

APAR PO06055, DEF
230690

While using the segment process box

APAR PO05496, DEF
230691

The flowchart corrupts after running a partially complete flowchart (due to a failed
asynchronous trigger)

APAR PO06323, DEF
230692

Track Process Box's Additional Fields window on Log tab is blank. User cannot specify
extra fields to the log.

DEF 230693 A parenthesis "(" in process box names is displays incorrectly in the Cell reports as a single
right square bracket "]".

APAR PO03844, DEF
230694

Scheduled flowchart Name is not displayed while scheduling eMessage Mailing.

APAR PO06206, DEF
230695

IBM Campaign Generated Fields for Custom Cell and Campaign attributes are not showing
for selection in all process boxes.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

APAR PO06439, DEF
230696

Cannot make a Teradata Connection after Upgrade.

APAR PO05915, DEF
230697

When user removes a field in the export column (personalization) of the mail list process
box

APAR PO04023, DEF
230698

When working at text audience level and attempting to write records into Contact History

APAR PO06660, DEF
231110

Users cannot remap dimensional tables in certain scenarios in Campaign.

DEF 232841 A user cannot rename a session flowchart.

APAR PO05937, DEF
232842

An error "Control cell is not linked to any target" occurs. Link 1 target cell & 1 Control cell
& assign to Sample PB, then Link some 2 other cells from TCS with the sample cells and
attach the new sample to maillist. Dont change anything in maillist to this link will be
dotted. Just open maillist and verify it still shows only TRGT1 and CTRL1. Save flowchart.
Now open first sample and unlink second cell CTRL1. Even after unlinking it keeps
showing as linked

PMR 229343, DEF
232916

Defect with chrome and enterprise mode (Performance issues in maillist).

PMR 228421 , DEF
232919

TCS: Segment column is not pinned.

APAR PO06424, DEF
232920

Issues with key fields when remapping dimension tables.

APAR 232283, DEF
232921

An error occurs if the project name contains invalid XML characters. The following message
is displayed: "An invalid XML character found in the value of attribute "name" and element
is "Flowchart".

APAR PO06336, DEF
232926

Optimize Extract process box loads records from the entire session.

DEF 233266 A newly created table in the database is not displayed in the alphabetically sorted list but is
displayed at the bottom of the Source Table dropdown box during Table mapping within a
Select process box.

APAR PO06641,
PO05664, DEF 233595,
206862

Scheduling a flowchart fails if the name of the flowchart has a + sign in it. Users must not
use a plus sign

APAR PO06647, DEF
233749

The Close button is not displayed in the Email Message Preview page and at times the
page stops responding.

DEF 234038 A user cannot map any table if the table starts with a number. After the fix any number or
underscore ( _ ) is truncated and a message is displayed. The user is now able to map the
table.

APAR PO05169, DEF
234420

Missing label in mail list process parameters tab.

APAR 218113, DEF
235306

When a user copies a template and pastes it in the template library the Snapshot process is
mapped to the first table in the list of table mappings.

APAR PO06728, DEF
235405

A user cannot select any date before 1970 for the offer attribute of type date.

DEF 237170 Long text in the email field is not accepted.

APAR PO06031, DEF
238205

Cannot increase the length of the datasource column in the table mapping screen of IBM
Campaign.

APAR PO06623, DEF
238451

A user cannot edit campaign target cells if the custom attribute of type "Select box" contains
string values with an apostrophe.
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Table 6. Campaign fixed defects (continued)

ID Fixed defect

APAR PO06777 , DEF
238517

Global suppression segment updating records with value 0 (zero)- Data from strategic
segment outputting null records when Global suppression segment applied to an Audience.
We able to reproduce this issue on our local environment.

DEF 238519 Extract process drops records with DB Loader when data type is number(x) and actual field
contains maximum negative x digits (converted to scientific notation).

APAR PO06811, DEF
238544

Select Process Box menu does not refresh after a segment is selected and the 'Select Based
on' value is displayed as None.

APAR PO06817, DEF
238723

Excessive Code Comments are displayed in the Campaign Error page.

APAR PO06844, DEF
239944

A user cannot download a flowchart log from the analysis tab of a campaign.

APAR PO06849, DEF
240150

The values for CLICKURL & URLDESCRIPTION are saved as NULL in the
UA_EMAILCLICK table in IBM Campaign.

DEF 240758 Scheduler Run status of flowchart is set as UNKNOWN in a cluster environment when the
scheduled flowchart run overlaps with a preceding run.

APAR PO06894, DEF
241329

Email process box crashes with INDB optimization enabled.

APAR PO06924, DEF
242555

Partitions/partition1 directory is converted to activeSession.udb file in a clustered
Campaign Listener environment.

APAR PO06954, DEF
243546

The Create table statement that is generated is invalid when the audience value is written
to the database from a Snapshot Process Box.

APAR PO07037, DEF
244174

The SMS and PUSH process box fails because the field mapping in the SMS process box is
incorrect.

APAR PO07079, DEF
246768

If a Table Mapping uses a file that has more than one dot (.) in between, the name is not
parsed correctly.

DEF 248942 When a custom security policy is configured any permissions revoked in custom security
policy are incorrectly applied to folders created with Global Policy.

DEF 249088 Offer Performance Summary by Campaign report was formed incorrectly from IBM Cognos
in Campaign. NOTE: This is fixed for use cases populating contact history only but not for
parameterized offer populating detail contact history.

DEF 270516 When a derived field that contains NULL values is exported to a database table via a
snapshot process box a 10404 error occurs when the flowchart is run.

PMR 228421, DEF
73523

The Source List values in the Custom Attribute Definitions editing page are not sorted in
alphabetical order.

PMR 238408, DEF
241311

UA_Email_Bounce does not populate Event_Name and Bounce_Type.

APAR PO06981, DEF
244290

Incorrect SQL is generated for a condition on unicode data in Select box.

APAR PO06873,
DEF237008

Campaign AudienceID column in IMC is populated with NULL audience value.

APAR 230602, Story
213165

Campaign pre-upgrade utility support Listener Cluster mode environment for health check.
Campaign Pre-Upgrade utility execution completed with error as follows. Enter Campaign
configuration file (provide full or relative path).
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Chapter 4. Known issues in IBM Campaign 10.1

Campaign 10.1 includes the following known issues.

Table 7. Campaign known issues

ID Known issue

276955 A fatal error occurs during the creation of an EAR file for deployment and a message is
added to the common installer logs. This message can be ignored. The EAR file is deployed
successfully in spite of this error.

The following entry can be seen in the common installer logs.

Custom Action: com.unica.install.ia.custom.StrIndexAndPieces

Status: ERROR

Additional Notes: ERROR - Unexpected Fatal Error in Class:
com.unica.install.ia.custom.StrIndexAndPieces.install()

13460 When the Export to File option is unchecked on the Fulfillment tab of the Mail List process,
the Summary File option is enabled but should not be.

175825 When defaultBehaviorWhenOutputToFile is set to Create New File, it works only when you
select a new output (export) file for the first time. If you try to change the existing output
file and select a new output file, then the option Append to Existing Data gets selected by
default.

It can be changed manually to Create New File.

APAR 198495,
PO05293, 198494

For a custom macro, if a user account has assigned as Not Granted permission for a stored
object (Custom Macros, Flowchart Templates, Stored Derived Fields, etc.), the custom macro
can be used to edit, delete, add, move all stored objects regardless of permissions.

204347 LARGE_DATA: Browser Crash - Mail List process box with 700 segments - Save with 512
offers to each segment.

211253 File-based input with multiple columns containing date in different format does not read
the date correctly.

212890 Boolean type column on Amazon Redshift is recognized as 'Test' field type in table
mapping.

220474 When the column name of the source table contains Non-ASCII characters and is long
(probably longer than 10 x 3bytes characters in UTF8), the Snapshot process does not run
because the temp table is not created.

220705 Profiling count for Dimension table fields is incorrect and profiling percentage is displayed
as 100% even if profiling is in progress.

APAR 222047,
PO06172, 222049

IBM Campaign extract process does not write to DB2 database when flowchart is
configured with two extract processes and the second extract process contains a derived
field that uses French accented characters in the name of the derived field.

APAR 225568,
PO06304, 225572

temptablepostexecutionsql is not run when selecting coremetrics segment.

226981 Campaign navigation URL format and Campaign/conf/config.xml Campaign navigation
format is incorrect when no port is specified during Campaign installation.

230340 Inconsistent behavior for the Mail list process is observed when the data filter is assigned to
Effective date on the Parameters tab in a new Mail list process when compared to an
edited existing Mail list process. The Mail list process does not output a datetime derived
field in the output log file. Changing the effective date parameter values might cause
execution failure of the Mail list.
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Table 7. Campaign known issues (continued)

ID Known issue

230606 In a flowchart where fields are extracted and used in a Mail list process, the fields under
Extract Node on the Personalization tab of the Mail list process are different before and
after running the process.

231859 While using the Chrome browser, it takes around 20 seconds to respond while loading the
Personalization tab of the Mail list process if it contains large number of treatments and
offers assigned. For example, a Mail list process with 250 cells, each cells with multiple
offers, each offer having multiple attributes.

232502 A Mail list performance issue occurs when the user changes the input in any way and there
is a delay when initially switching tabs. After the user changes the input and switches to
the Treatment or Process tab for the first time, there is a delay of around 10-15 seconds
depending on the number of inputs selected. After this initial delay, there is no delay until
the input is changed.

232835 The Campaign application performance is affected and sometimes an exception error
message is displayed on the Campaign pages when the application is used for a longer
time (some days) with continuous usage. You must restart your Campaign web application
and Campaign Listeners

238789 While using the Chrome browser, when a user opens a Mail list with 600 cells having
multiple offers assigned to each cell, the application stops responding. While using the
Internet Explorer 11 browser, nothing is displayed in the Mail list process box.

APAR 238830,
PO06822, 238832

Roles assignment does not work in Campaign and a user is able to create a custom macro
even if the user does not have the permission to create the custom macro, has the
permission for Folder Owner and Owner roles, and is neither the folder owner nor the
owner.

239142 When the Audience process fails because of an incorrect Count filter expression, and the
user removes the filter expression, adds a Condition, and runs the Audience process again,
the process fails. The Condition is not considered and instead the previous Count filter
expression is used resulting in the failure. To run the Audience process successfully, you
must re-open the Audience process configuration window, click the Condition, Save and
Close. The Audience process now considers the Condition and runs successfully.

APAR 243895,
PO06966, 243897

A space character is converted to ’’ while profiling.

PMR 223848, 245664 Irrelevant flowcharts turned up in a Campaign when different users access different
flowcharts at the same time, the wrong flowchart seems to be displayed.

APAR 246662,
PO07061, 246664

The Segment analysis tab is not displayed correctly after the user views the Segment cross
tab analysis report.

248007 Hive Performance: PRE -Single Insert statements executed for loading data in temp tables
(extract) when used with Hive takes 19 minutes for 2000 records.

APAR 267287,
PO07170, 267288

Users cannot add an apostrophe in the text for a Derived field or a User variable.

269729 Persistent Derived field created in English locale is not displayed in French locale.

PMR 269280, 269765 Truncate does not function for the DB2 database. The DeleteAsTruncate property specifies
whether, when an output process is configured to REPLACE TABLE, Campaign uses TRUNCATE
TABLE or deletes from the table. When the value is TRUE, Campaign runs a TRUNCATE TABLE
from the table. When the value is FALSE, Campaign runs a DELETE FROM from the table. The
default value depends on the database type, with a large number of clients moving from
Oracle to DB2 the difference in performance is extremely noticeable. The comparison in
performance in Snapshots and Mail lists for customers leaving Oracle to DB2 is drastic.

269785 For the Chrome and Safari browsers, when the locale is set as Japanese, the labels overlap
the buttons in the Save template window.
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Table 7. Campaign known issues (continued)

ID Known issue

270528 Use and Profile buttons remains enabled for the Select process when the user selects some
table fields and then applies the search filter in the Select process such that it does not
return any matching table.

270614 An error occurs when the user tries to load/delete table catalog which is saved as XML
with data folder specified.

270814 Users cannot select values from the On a trigger drop down by using the mouse on the
Scheduler page.

271466 When the audience level has two fields, the second field cannot be mapped correctly
during table mapping. Workaround Re-open the drop down and map the second field.

271576 Campaign Application deployment completed with errors on WAS 8.5.0.2. The errors can be
ignored.

271642 A "Please wait....." message is displayed multiple times in console mode installation
while upgrading from version 10.0.

271676 The Extract table on the DB2 and Oracle databases is not deleted when In-DB optimization
is unchecked.

272253 The Campaign application performance is affected when a user opens the Table mapping
window and more than 500 tables are mapped.

273311 While using the Internet Explorer on a Windows 8 OS, the Derived Field window is not
displayed correctly while adding new Derived field.

245712, PO07040,
273513

A Performance issue occurs in clustered Campaign listener environments due to
versioning/uniqueness of individual unica_tbmgr.cache files.

273652 The server process crashes when Max size is set to zero and Create extract tables is
checked in Segment process.

2968 Hot keys are not implemented on most of the windows. In the Dojo implementation it is
not possible to use keyboard shortcuts to activate certain functions. Instead the user must
click buttons.

PMR 266519, 75262 Clicking Return to previous page distorts the user interface in some cases. Use the links
within the products to navigate, rather than the browser controls.

ENH 65216 User variables with more than 32 characters is not supported in Campaign flowchart. If
user wants to extract the values of a user variable using Extract table, Temp tables, or
database tables user variable length should be less than 32 char. If user wants to map user
variable with user created table column with more than 32 char in this case user variable
value can be more than 32 char long.

N/A When IBM Campaign 10.0.0.1 (10.0.0 FP1) is deployed in an application server cluster
environment with 80 port, the Campaign navigation URL should not contain this port
number. For example: http://<host>.<domain>:80/Campaign should be changed to
http://<host>.<domain>/Campaign. Change the value of the serverURL property under
Campaign|navigation on the Settings > Configuration page.

N/A Mail List process box gets unconfigured with error "31606: History table are changed"
on Flowchart run.

1. There is no issue if the history tables are mapped prior to building a flowchart and
adding a Mail List process.

2. If you do not follow step 1, you can still map the history tables after the error appears.
If you edit the flowchart and configure the process box, the process will run.

N/A After migrating non-ASCII data to Campaign 8.6, in some cases you cannot open Campaign
flowcharts on the target system. Session flowcharts open successfully. To work around this
issue, remigrate the campaigns in overwrite mode. You can then open the flowcharts.
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Table 7. Campaign known issues (continued)

ID Known issue

TT 062333 Information related to associated products does not appear in offer on Marketing
Operations. When an offer created in Campaign with products associated with it is
imported in Marketing Operations, information about the associated products is not
available in Marketing Operations.
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Chapter 5. Known limitations in IBM Campaign 10.1

Campaign 10.1 includes the following known limitations.

Table 8. Campaign known limitations

ID Known limitation

11162 Several dialogs that might not contain a large amount of data or are not commonly used
cannot be resized or maximized.

17202 Error 19024: Cannot delete segment folder if the segment was deleted from the folder. A
segment that is deleted from a folder remains as an inactive segment in the folder. Folders
with inactive segments cannot be deleted. This is working as intended.

185854 Big data: Campaign integration with Hadoop-based Hive big data as a user data source is
not tested on MS Windows operating system.

18991 If the same flowchart is edited in multiple locales, undesired behavior can occur. This
situation occurs only if two (or more) users with different language settings edit the same
flowchart. Users with different locales should not edit the same flowchart that was created
by a user with a different locale since this can lead to undesired behavior

190621 Big data: Campaign with Hive big data as a user database does not support user table
mapping with Base and Dimension levels up to the fourth level hierarchy. If you map a
Base record table with four levels of dimension tables in a Select process box, then build a
query based on the fourth level Dimension table, the query fails with Error 11528. This
issue should not affect big data users because multiple dimensions should not be needed.
By definition, a big data source has a large table of records split across Hadoop nodes (such
as HDFS).

194095 For Redshift database, the error message "Unsupported type timestamps with time zone" is
displayed when exporting data from a Snapshot process box. Timestamp with timezone is
an unsupported PostgreSQL data type on Amazon AWS.

195581 While running a Campaign flowchart, if listener crashes or is stopped, user is not able to
access the running flowchart from the UI. Requests are being served by another node of the
cluster but while accessing the flowchart, a pop-up message says "listener failover
occurred..." It may be necessary to restart the master listener.

222934 Search performance on the Advanced Search UI: The time for search results to appear on
the UI, when the page size is 500 is somewhat long. For example, it takes about 30 seconds
on IE11. For other page sizes, such as 10 (default), 25, 50 and 100, the performance is good.

232032 User can start only one IBM Campaign listener on one server (machine) in case of Listener
clustering.

PMR 243195, 244148 When a column that has the Greek Letters A and B is profiled in Campaign, the system
returns only A along with the count of all the records. After the fix, some of the
non-English characters, which differ only in case (like é and É in French), are counted as
two different values in profiling. English language characters are not counted as case
sensitive.

244482 Deep search lists all the Campaigns that are created through Marketing Operations projects
when Campaign - Marketing Operations integration is on. Campaigns that are created
through Marketing Operations projects when Marketing Operations - Campaign integration
is enabled) are not listed on Campaign list page and are only available on the Marketing
Operations project listing page. Users who do not have the permission to access Marketing
Operations are able to access campaigns which are created through Marketing Operations
projects through Deep search results.
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Table 8. Campaign known limitations (continued)

ID Known limitation

248943 If the user profile database is changed (change in the table column values of audience
record) for fields other than sync fields and the user runs the Email process again, a
negative count is returned for the DUPLICATES parameter from Engage in the Campaign
flowchart log.

N/A Big data: To perform the UPDATE operation on any process boxes in a flowchart, ensure
that your HIVE tables are configured as transactional tables such that they support the
ACID property. This is a key feature introduced in HIVE version 0.14.

N/A IBM Interact when configured with IBM WebSphere Application Server: You must configure
IBM WebSphere JVM to use JDK 1.7. When IBM WebSphere Application Server 8.5.5.x is
configured with JDK 1.7 and HTTPS communication, you must use IBM JAVA SDK version
7.0.8.10 or higher.

N/A Using multiple SQL statements for raw SQL queries is not currently supported on big data
user datasources. For related information, search the IBM Knowledge Center for Hive query
language conformance.

N/A Dialog behavior: In certain cases, it is necessary to click twice in order to activate a field or
change a field value.

N/A The monitorEnabledForEmessage configuration property in Campaign|monitoring is not
currently used.

N/A Relevant products limitation: When offer management is performed from IBM Marketing
Operations, the "relevant products" functionality, which relates product IDs to offers, is not
available.

N/A Blank or incorrect results from derived fields in a Mail List process. This can occur in a
process box that uses a derived field that calls a Generated field (UCGF) that changes
value.

Do not use a UCGF in a Mail List derived field if the UCGF is not constant. Also, from the
Parameters tab, do not create a derived field to call a UCGF to populate offer attributes.

For details, see the following Tech Note: http://g01zciwas018.ahe.pok.ibm.com/support/
dcf/preview.wss?host=g01zcidbs003.ahe.pok.ibm.com&db=support/swg/istech.nsf
&unid=C4A93DC0ED188D6985257A6B00699C45&taxOC=SSCKNRB&MD=2012/08/31
%2015:08:35&sid=

N/A Profiling a Campaign Generated Field (UCGF) does not yield correct results. Some UCGFs
have a value according to the cell or the offer being processed. For cell-related UCGFs, only
the value associated with the first cell appears during profiling.

N/A The default value for a custom cell attribute does not appear when you open the target cell
spreadsheet. Although the default value is not initially displayed, it will be used. The value
can be displayed or changed by clicking or opening and editing the custom cell attribute in
the target cell spreadsheet.

N/A The UA_UsrResponseType.Name field cannot contain a left parenthesis followed by a single
quote.
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Table 8. Campaign known limitations (continued)

ID Known limitation

N/A Use unique TempTablePrefix for each data source when mapping multiple data sources to
same physical database.

If you mapped multiple data sources in Campaign to the same physical database, and you
use the same TempTablePrefix for more than one of the data sources, when you use the
cleanup utility to delete orphaned temp tables, it may falsely identify temp tables as
orphaned, when they are in fact legitimate temp tables defined from a different Campaign
data source.

Any deleted temp tables will automatically be recreated when you rerun affected
flowcharts, but as a best practice, use a unique TempTablePrefix for each data source when
mapping multiple data sources to the same physical database.

If the data sources defined in Campaign map to different schemas in the database, another
solution is to ensure that the database user who runs the cleanup utility does not have
privileges to drop tables in other schemas in the same database.

161323 The error "Login failed. Error 10553" can occur if you try to log in to the Campaign utilities
when the IBM Marketing Platform | Security | login method is set to Windows
integrated login or Web access control. To avoid this issue, change the login type to LDAP
or IBM Marketing Platform prior to using the Campaign utilities..

176377 DB2 10.5 BLU for user DB: No indexing requirement for temp tables in Campaign
datasource. DB2 10.5 (with BLU feature ON) does not require indexing in Campaign.
Campaign has certain properties for datasources, such as TempTablePreTruncateRunScript,
TempTablePostExecutionSQL, and PostTempTableCreateRunScript, where you can provide
SQL or scripts to create indexes on user database tables. If you are using DB2 10.5 as a
customer database, with the BLU feature ON, you do not need to configure any of these
temp table properties.

201,968,200,241 If two process boxes are moved very close together in a flowchart, the direction of the
connection arrow changes. This limitation affects the visual representation of the arrow. The
process data flow is not affected. The workaround is to move the process boxes farther
apart so the arrowhead changes back to the correct direction.

211293 In IBM Campaign, the built-in macro Current_Date() results in an error when executed
against a Hive 1.2 based Big Data instance. The Hive ODBC driver does not support the
CURRENT_DATE macro to obtain interval values. For example, executing the following
query results in a Hive error:

SELECT DISTINCT customerid FROM Customer_date WHERE
((Customer_date.my_date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from type: interval_day_time

Workaround: To use the CURRENT_DATE function in a RAW SQL query on Hive with
Hortonworks, execute SQL in the following format:

SELECT DISTINCT customerid FROM Customer_date WHERE (current_date() -
my_date_mmdyyyy ) = interval '0 0:0:0' day to second

213088 If IBM Campaign is installed in a secured environment but IBM Cognos is in an unsecured
environment, Cognos reports will not display when you use Microsoft Internet Explorer 11.
Workaround: If IBM Campaign is configured with HTTPS, also configure IBM Cognos on
HTTPS.

217488 IBM can support the Database Loader for Redshift until the moment Campaign triggers the
Loader Script. Any problems in execution of the loader script are not supported by IBM.
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Table 8. Campaign known limitations (continued)

ID Known limitation

223716 Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you can use the following workaround to
ensure application security.

Complete the following steps to update web.xml.

1. Update the web app tag and set the xsd version to 3.0.

<web-app xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns="http://java.sun.com/xml/ns/javaee"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"
id="Platform" version="3.0" metadata-complete="true">

2. Add the following in web.xml.

<!--[start] WhiteList Http Verbs -->
<security-constraint>
<web-resource-collection>
<web-resource-name>Unica_WhiteList_Http_Verbs</web-resource-name>
<url-pattern>/*</url-pattern>
<http-method-omission>GET</http-method-omission>
<http-method-omission>POST</http-method-omission>
<http-method-omission>TRACE</http-method-omission>
<http-method-omission>PUT</http-method-omission>
<http-method-omission>DELETE</http-method-omission>
<http-method-omission>PATCH</http-method-omission>
<http-method-omission>OPTIONS</http-method-omission>
<http-method-omission>HEAD</http-method-omission>
</web-resource-collection>
<auth-constraint/>

</security-constraint>
<!--[end] WhiteList Http Verbs -->
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Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to
track campaign, offer, and cell performance. To use the Reports Package, Campaign
must be integrated with IBM Cognos

For more information, see the IBM Marketing Software Reports Installation and
Configuration Guide that is supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:
v Schemas that are registered with IBM Marketing Platform during installation.

They describe the attributes and metrics that represent the product's reporting
schema and include:
– Base schemas that are the basis of the reporting schema (with no custom

attributes)
– Custom versions of most of the base schemas that rely on the preconfigured

custom attributes for Campaign
– Templates that you can use to create new schemas

v IBM Cognos customizable model and reports to be deployed on an IBM Cognos
BI Server

v Reference documentation that describes the IBM Cognos model and the reports.
Documentation can be found in the directory ReportsPackCampaign\cognos10\
CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system
tables.

Reporting Schemas

The following reporting schemas are provided:
v Campaign Views provides the standard attribute views of the Campaign system

tables (campaign, offer, cell, and so on).
v Campaign Custom Attributes is for reporting on custom attributes of campaigns,

offers, and cells.
v Campaign Performance is used by reports that display performance

measurements starting at the campaign level over all time or various periods of
time (days, months, and so on).

v Offer Performance is used by reports that display performance measurements
starting at the offer level over all time or various periods of time (days, months,
and so on).

v Campaign Offer Response Breakout is used by reports that show campaign and
offer responses based on response types.

v Campaign Offer Contact Status Breakout is used for measurement of campaign
and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the
default, preconfigured response types, custom attributes, and so on.
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Templates

If you have additional audience levels, you can create additional reporting schemas
for them with the following templates:
v Campaign Views
v Campaign Custom Attributes
v Campaign Performance
v Offer Performance
v Campaign Offer Response Breakout
v Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from
the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be
displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign
Analysis tab:
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell with Revenue
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
v "What If" Offer Financial Summary
v Offer Performance by Day
v Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple
objects in Campaign. These reports are available from the Campaign Analytics
page.
v "What If" Offer Financial Summary
v Campaign Detailed Offer Response Breakout
v Campaign Financial Summary by Offer (Actual)
v Campaign Offer Performance by Month
v Campaign Performance Comparison
v Campaign Performance Comparison (with Revenue)
v Campaign Performance Comparison by Initiative
v Campaign Performance Summary by Cell
v Campaign Performance Summary by Cell (with Revenue)
v Campaign Performance Summary by Cell by Initiative
v Campaign Performance Summary by Offer
v Campaign Performance Summary by Offer (with Revenue)
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v Campaign Performance Summary by Cell and Offer
v Campaign Performance Summary by Cell and Offer (with Revenue)
v Campaign Summary
v Offer Campaign Listings
v Offer Performance by Day
v Offer Performance Comparison
v Offer Performance Metrics
v Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on
dashboard pages:
v Campaign Response Rate Comparison
v Campaign Return on Investment Comparison
v Campaign Revenue Comparison by Offer
v Offer Response Breakout
v Offer Response Rate Comparison
v Offer Responses for Last 7 Days
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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